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XPression Maps Software Installation Guide

This guide provides details about the XPression Maps software installers, along with instructions on where and how
to install them. We recommend reading the entire guide before beginning any installation.

The following topics are discussed in this guide:

XPression Maps Configurations and Installation Files[ 2
Installing the MariaDB Server/

Installing the XPression Maps Gateway Software[ 17\
Installing the XPression Maps Core Software/ 24"
Activating XPression Maps Licenses| a3

Opening XPression Maps User Interfaces| s
Uninstalling XPression Maps Software Components/so

XPression Maps Port Requirements| st
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XPression Maps Configurations and Installation Files

For XPression Maps to operate correctly, required software components and support files must be installed in
specific locations, which is determined by the product configuration and deployment environment.

Use the topics below to review the available configurations and to identify which files are required and where they
must be installed.

A detailed description of the files, including their purpose and usage, is also provided in the Installation File
Reference Table| sV at the end of this section.

XPression Maps Designer System Configurations/ 3"
XPression Maps Server System Configuration| 4"

XPression Maps Touch System Configurations/[ s"
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XPression Maps Designer System Configurations
XPression Maps Designer systems are typically deployed in one of two configurations:

e Single Designer workstation with a local database — suited for standalone use, with both the application and
the database hosted on the same machine.

« Multiple Designer workstations with a shared database — suited for collaborative use, with one workstation
hosting the database while others connect to it. This setup ensures consistency across users but requires the
database to remain continuously accessible.

Refer to the table below to determine which files must be installed and where, based on your selected configuration.

System Configuration Installation Location Installation Files
Single Designer workstation Designer workstation 1. Blue Marble Map Database
with a local database (BMMap4.db)
2. Blue Marble Map Height Model
(SRTM1.db)

. XPression Maps Core Installer[2"

3

4. Release Notes
5. Rockey License*
1

Multiple Designer workstations  Designer workstation that hosts the 1. MariaDB Installer [}

with a shared database shared database
X The MariaDB Installer must remain

accessible at all times for this
configuration.

2. MariaDB_Changes_v2.txt

3. Blue Marble Map Database
(BMMap4.db)

4. Blue Marble Map Height Model
(SRTM1.db)

XPression Maps Core Installer[2
Release Notes

Rockey License*

il I

Designer workstations Blue Marble Map Database

(BMMap4.db)

2. Blue Marble Map Height Model
(SRTM1.db)

3. XPression Maps Core Installer[2"
4. Release Notes
5. Rockey License*

* The Rockey License installation file is required only if a license is not being added through the Ross Platform
Manager (RPM).
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XPression Maps Server System Configuration

XPression Maps Server systems are typically deployed as Multiple Designer workstations with a shared database and
access to the Web Client application. In this configuration, the database and related services are hosted on the
XPression Maps Server, while Designer workstations connect to the server for database access and collaborative
operation. This approach ensures centralized data management, consistency across users, and support for multi-
user workflows.

Refer to the table below to determine which files to install and their required locations for this configuration.

System Configuration Installation Location Installation Files

Multiple Designer workstations  Designer workstations 1. Blue Marble Map Database
with a shared database and (BMMap4.db)

access to the Web Client

2. Blue Marble Map Height Model

application (SRTM1.db)

. XPression Maps Core Installer[2"

3

4. Release Notes
5. Rockey License*
1

XPression Maps Server . MariaDB Installer 1"

X The MariaDB Installer must remain
accessible at all times for this
configuration.

2. MariaDB_Changes_v2.txt

3. XPression Maps Gateway
Installer[+"

4. Blue Marble Map Database
(BMMap4.db)

5. Blue Marble Map Height Model
(SRTM1.db)

6. XPression Maps Core Installer|24
7. Release Notes
8. Rockey License*

* The Rockey License installation file is required only if a license is not being added through the Ross Platform
Manager (RPM).
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XPression Maps Touch System Configurations

XPression Maps Touch systems are typically deployed in one of three configurations:

¢ Single Touch Engine without MOS worflow — suited for individual or small-scale use, where touch interaction
is required on a single output and newsroom integration is not needed. Designer workstations connect to a
centralized database hosted on the XPression Maps Touch Engine.

¢ Multiple Touch Engine without MOS workflow — suited for collaborative or large-scale environments, where
touch interaction is required across multiple outputs and newsroom integration is not needed. Designer
workstations connect to a centralized database hosted on a designated XPression Maps Touch Engine.

e Multiple Touch Engines with MOS workflow — suited for collaborative or large-scale environments, where
touch interaction is required across multiple outputs and newsroom integration is needed. Designer workstations
connect to a centralized database hosted on an XPression Maps Server.

Refer to the table below to determine which files must be installed and where, based on your selected configuration.

System Configuration Installation Location Installation Files
Single Touch Engine without Designer workstations 1. Blue Marble Map Database
MOS workflow (BMMap4.db)
2. Blue Marble Map Height Model
(SRTM1.db)

. XPression Maps Core Installer[2"

3

4. Release Notes
5. Rockey License*
1

Touch Engine . MariaDB Installer [

X The MariaDB Installer must remain
accessible at all times for this
configuration.

2. MariaDB_Changes_v2.txt

3. XPression Maps Gateway
Installer[+"

4. Blue Marble Map Database
(BMMap4.db)

5. Blue Marble Map Height Model
(SRTM1.db)

6. XPression Maps Core Installer|2:
7. Release Notes

8. Rockey License*
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System Configuration Installation Location Installation Files
Multiple Touch Engines without | Designer workstations 1. Blue Marble Map Database
MOS workflow (BMMap4.db)
2. Blue Marble Map Height Model
(SRTM1.db)

. XPression Maps Core Installer[2"

3

4. Release Notes
5. Rockey License*
1

Touch Engine 1 . MariaDB Installer [}

X The MariaDB Installer must remain
accessible at all times for this
configuration.

2. MariaDB_Changes_v2.txt

3. XPression Maps Gateway
Installer[+"

4. Blue Marble Map Database
(BMMap4.db)

5. Blue Marble Map Height Model
(SRTM1.db)

XPression Maps Core Installer[2
Release Notes

Rockey License*

e N o

Touch Engine X Blue Marble Map Database

(BMMap4.db)

Blue Marble Map Height Model
(SRTM1.db)

XPression Maps Core Installer[2"

N

Release Notes

Rockey License*

il

Multiple Touch Engines with MOS Designer workstations Blue Marble Map Database
workflow (BMMap4.db)

2. Blue Marble Map Height Model
(SRTM1.db)

3. XPression Maps Core Installer[2"
4. Release Notes

5. Rockey License*
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System Configuration Installation Location Installation Files

XPression Maps Server 1. MariaDB Installer [ 10}

X The MariaDB Installer must remain
accessible at all times for this
configuration.

2. MariaDB_Changes_v2.txt

3. XPression Maps Gateway
Installer[+h

4. Blue Marble Map Database
(BMMap4.db)

5. Blue Marble Map Height Model
(SRTM1.db)

XPression Maps Core Installer[2
Release Notes

Rockey License*

Hl® N O

Blue Marble Map Database
(BMMap4.db)

2. Blue Marble Map Height Model
(SRTM1.db)

3. XPression Maps Core Installer[2"

Touch Engine(s)

4. Release Notes

5. Rockey License*

* The Rockey License installation file is required only if a license is not being added through the Ross Platform
Manager (RPM).

: ROSS




XPression

Installation File Reference

This table provides a comprehensive reference to the installation files required for deploying the XPression Maps
software suite. Each file is listed with its specific function, role in the installation process, and associated
dependencies. Where applicable, links to related procedures and configuration steps are included to support correct
setup and integration. Use this reference as a guide to ensure all mandatory files are identified, installed, and
configured properly for a successful deployment.

Blue Marble Map Database: BMMap4.db

The Blue Marble Map Database file contains a collection of satellite images that depict the Earth in true color.
This file is needed during the installation of the XPression Maps Core software. See Installing the XPression Maps
Core Softwarel 24" for more information.

Blue Marble Height Model: SRTM1.db

The Blue Marble Height Model file is used to provide elevation data to the Blue Marble map imagery to create a
visually realistic 3D representation of Earth's surface. This file is needed during the installation of the XPression
Maps Core software. See Installing the XPression Maps Core Softwarel 2" for more information.

MariaDB Server: mariadb-11.4.5-winx64.msi

The mariadb-11.4.5-winx64.msi file launches the MariaDB Setup Wizard, which guides you through the
installation and configuration of the MariaDB server. This server manages and provides centralized access to
shared databases used by multiple XPression Maps instances. See Installing the MariaDB Server[ 1 for more
information.

MariaDB_Changes v2.txt

This document provides step-by-step instructions for completing a mandatory configuration that must be
performed the first time XPression Maps is launched. See Adding a required setting to the MariaDB service's my.ini
file[16" for more information.

Release Notes: XpressionMapsReleaseNotes.txt

This document identifies major functional changes and improvements that have been added to this version of the
XPression Maps software since the last official product release.

Rockey License: RockeyLicense_XXXXXXXX.xml

The RockeyLicense_XXXXXXXX.xml file is an encrypted key file that, when paired with a matching XPression
USB dongle, activates the XPression Maps license on the host computer by enabling secure access to its software
components. This method provides an alternative to using RPM-based licenses. See Activating an XPression Maps
Licensels3) for more information.

XPression Maps Core Installer: XPressionMaps_V4.X.X.XXX_Installer.exe

Installs the XPression Maps Core software, including the XPression Maps application, as well as other software
components and files required to support optional data automation and interactive touch functionality. The
XPression Maps Exchange Tool and the Map Data Configurator application are also installed with the
XPression Maps Core software. See Installing the XPression Maps Core Software[ 24 for more information.
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XPression Maps Gateway Installer: XPression Maps Gateway_V4.X.X.XXX_Installer.exe

Installs the XPression Maps Gateway software, which is the web server that allows the XPression Maps Web
Client and Touch Controller, to connect to and interact with the XPression Maps system. See Installing the
XPression Maps Gateway Softwarel+7 for more information.

XPression Maps RPM License Manager Installer: XPressionMapsRPMLicenseManager_Installer.exe

Installs the XPression Maps RPM License Manager, which allows you to manage and activate XPression Maps
licenses through the Ross Platform Manager, providing access to license activation and feature management. See
Activating an XPression Maps Licensel " for more information.
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Installing the MariaDB Server

The MariaDB server provides centralized access to shared databases used by multiple XPression Maps instances.

In XPression Maps Server| 4% and Multiple Touch Engines with MOS workflow! 5" configurations, the MariaDB Server
is generally installed on the XPression Maps Server.

In configurations that do not use MOS but include multiple XPression Maps Designers, or a combination of XPression
Maps Designers and an XPression Maps Touch system, the MariaDB server must be installed on a computer that is
always accessible to the other instances and remains powered on at all times.

Perform the following procedures to install and configure the MariaDB server.

Installing the MariaDB Server/ 1

Adding a required setting to the MariaDB service's my.ini file[ 1

X When installing multiple XPression Maps components, they must be installed in the following order: MariaDB
Server, XPression Maps Gateway, and finally XPression Maps Core software.

To install and configure the MariaDB server:

1. Move a copy of the mariadb-11.4.5-winx64.msi file to the centralized host computer.
2. Double-click the mariadb-11.4.5-winx64.msi file to run the MariaDB Setup Wizard.

3. On the Welcome page, select Next.

"M MariaDB 11.4 (x64) Setup - b

Welcome to the MariaDB 11.4 (x64)
Setup Wizard

The Setup Wizard will install MariaDB 11.4 (x54) on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard,

MariaDB

[ Next ] Cancel

MariaDB Setup Wizard - Welcome
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4. On the End-User License Agreement page, select the checkbox and select Next.

" MariaDB 11.4 (x64) Setup - be
End-User License Agreement Ma ri aDB ,
Please read the following license agreement carefully Server =4

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.., 51 Franklin
Street, Fifth Floor, Boston, MA 02110-1335 USA Everyone is permitted
to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

Preamble

The licensas for most software are desionaed to take awav vour freednm

B 1 accept the terms in the License Agreement

Print Back [ Next ] Cancel

MariaDB Setup Wizard - License Agreement

5. On the Custom Setup page, leave all of the default settings unchanged and select Next.

"8 MariaDB 11.4 (x64) Setup = *x
Custom Setup MariaDB i
Select the way you want features to be installed. Server &4

Click the icons in the tree below to change the way features will be installed.

Install server
Database instance
Client Programs
- (=8 ~ | Backup utilities
e 2T De.ve\opment components This feature requires 173ME on
== = | Third party tools your hard drive. It has 3 of 3
I g-l HeidisQL subfeatures selected. The
subfeatures require 83ME on your
hard drive.
Location: Ct\Program Files\MariaDB 11.4% Browse. ..
Reset Disk Usage Back [ Next ] Cancel

MariaDB Setup Wizard - Custom Setup
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6. On the Default Instance Properties page, do the following:

a. Set and confirm the password for the root user.

X The root password created here must be saved in a secure location, as it will be required later in the
installation process.

b. Select the checkbox for Enable access from remote machines for 'root' user.
c. Select the checkbox for Use UTF8 as default server's character set.

d. Select Next.

"8 User settings = *
Default instance properties MariaDB T
MariaDB 11.4 (x&64) database configuration Server =4

Modify password for database user "root’

New root password: assss Enter new root password
Confirm: I Retype the password

Enable access from remote machines for
‘root’ user

Use UTF8 as default server's character set

Data directory |C:‘,Program Files\MariaDB 11, 4\data, Browse...

Back [ Next ] Cancel

MariaDB Setup Wizard - Default Instance Properties

7. On the Default Instance Properties page, leave all of the default settings unchanged and select Next.

"M Database settings -

Default instance properties MariaDB i
MariaDB 11.4 (x64) database configuration Server & -j/‘

B 1nstall as service

Service Name: [Maraoe

Enable networking

TCP port: |3306

Innodb engine settings
Buffer pool size: 3161 MB

Page size: 16 KB

Back Next Cancel

MariaDB Setup Wizard - Default Instance Properties
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8. On the Ready To Install MariaDB page, select Install.

b ]

Ready to install MariaDB 11.4 (x64) Mari EJ DB ;/ /
>erver =

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back ¥ Install Cancel

MariaDB Setup Wizard - Ready To Install MariaDB
9. On the Completed the MariaDB Setup Wizard page, select Finish.

"8 MariaDB 11.4 (x64) Setup = *x

Completed the MariaDB 11.4 (x64) Setup
Wizard

Click the Finish button to exit the Setup Wizard.

MariaDB

[ Fnsn

MariaDB Setup Wizard - Completed the MariaDB Setup Wizard
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10. Change the MariaDB service's Log On property from NT SERVICE\MariaDB to the Local System account.

a. Open the Windows Services application and navigate to the MariaDB service.

T

Services = [m] X

File Action View Help

G EEEN I D

Services (Local) " Services (Local)
MariaDB MName - Description Status Startup Type Log On As
&4 MariaDB MariaDB da.. Running Automatic MNT SERVICE\MariaDB
%_f;::;:?g:\:ce £ McpManagementService Universal Pr... Manual Local System
£ MessagingService_Sbdfc2 SErvice sup... Manual (Trigger Start) Local System
& Microsoft Account Sign-in...  Enablesuse.. Running  Manual (Trigger Start) Local System
Description: St Microsoft App-V Client Manages A... Disabled Local System
MariaDB datzbase server S Microsoft Cloud |dentity Se...  Supports int... Manual Metwork Service
& Microsoft Cloud Managed ... Microsoft C... Automatic (Delayed Start) Local System
S Microsoft Defender Antiviru... Helps guard... Manual Local Service
& Microsoft Defender Antiviru.., Helps prote..  Running  Automatic Local System
S Microsoft Defender Core Se... Monitorsth..  Running  Automatic Local System
& Microsoft Device Inventory .. Microsoft D..  Running  Automatic Local System
& Microsoft Edge Elevation Se... Keeps Micr... Manual Local System
) £ Edon Vedobe G Ve, NSRRI, Wy ey [y -

\ Extended /(Standard

Services Window
b. Right-click on the MariaDB service and select Stop.
c. Right-click on the MariaDB service and select Properties.

d. In the MariaDB Properties window, select the Log On tab.

MariaDB Properties (Local Computer) x

General LogOn  Recovery Dependencies

Log on as:

() Local System account

© This accourt: NT SERVICE\MariaDB EBrowse...
Passward:
Corfimpassword: ~ $eseesssssssses
OK Cancel Apply
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e. In the Log on as section, select the Local System account option and then select OK.

MariaDB Properties (Local Computer) X

General LogOn  Recovery Dependencies

Log on as:

© Local System account
[ Allow service to interact with desktop

() This accourt

l QK ] Cancel Hpply

f. In the Services window, right-click on the MariaDB service and select Start.

g. Close the Windows Services window.
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To add a required setting to the MariaDB service's my.ini file:

1. Open the Windows Services application and navigate to the MariaDB service.

r

Services = O X
File Action View Help

a|E B Hm »ann

Services (Local) . Services (Local)
MariaDB Narne . Description Status Startup Type Log On As
X G MariaDB da.. Running Automatic INT SERVICE\MariaDB
%_if:‘:;:;:::ce _’_\j‘;McpManagEmentSeNi(e Universal Pr... Manual Lacal System
Ll MessagingService_Sbdfc2 Service sup... Manual (Trigger Start) Local System
L Microsoft Account Sign-in ...  Enables use.. Running  Manual (Trigger Start) Local System
Description: L Microsoft App-V Client Manages A... Disabled Local System
MarizDB database server S Microsoft Cloud Identity Se...  Supports int... Manual Metwork Service I
L Micrasoft Cloud Managed ... Microsoft C... Automatic (Delayed Start) Lacal System
S Microsoft Defender Antiviru... Helps guard... Manual Local Service
L Microsoft Defender Antiviru.. Helps prote.. Running  Automatic Local System
Ck:Microsoft Defender Core Se... Monitorsth.. Running  Automatic Local System
Ck:Microsoft Device Inventory .. Microsoft D, Running  Automatic Local System
) Microsoft Edge Elevation Se... Keeps Micr... Manual Local System
[N VI S T O Ao abic (Pl oond Chok Vool Sk

\ Extended /(Standard

Services Window
2. Right-click on the MariaDB service and select Stop.
3. In File Explorer, navigate to C:\Program Files\MariaDB 11.4\data and open the my.ini file.

X The required changes to the my.ini file are also documented in the MariaDB_changesv2.txt/ " file, which is
provided in the installer package. Refer to this file if you need a complete reference of the configuration steps.

4. Add the following setting below the character_set_server setting: max allowed packet = 500M.

E my.ini +

[mysqld]

datadir=C:/Program Files/MariaDB 11.4/data
port=3386

innodb_buffer_pool_size=8161M
character-set-server=utf8mb4

max_allowed_packet = 588M h

[client]

port=3386

plugin-dir=C:\Program Files\MariaDB 11.4/1ib/plugin

5. Save the changes and close the my.ini file.
6. In the Services window, right-click on the MariaDB service and select Start.

7. Close the Windows Services window.
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Installing the XPression Maps Gateway Software

The XPression Maps Gateway is the web server that allows XPression Maps to connect and interact with the
HTMLS5 Client in the XPression Maps Server (MOS) workflow, as well as between XPression Maps Touch and the
Touch Controller in the XPression Maps Touch (Interactive) workflow.

The installation location of the XPression Maps Gateway depends on the system configuration and workflows. See
XPression Maps Configurations and Installation Files[ 2% for more information.

X When multiple XPression Maps software components are required to be installed on the same computer, they

must be installed in the following order: MariaDB Server, XPression Maps Gateway, and finally XPression
Maps Core software.

To install, update, or upgrade the XPression Maps Gateway software:

1. Copy the XPression Maps installation files to the local file system.
2. Open the folder where the installation files have been stored.
3. Double-click the XPression Maps Gateway_VX.0.0.XXXXX_Installer.exe file to open the XPression Maps

Gateway Install Wizard.

4. On the Welcome page, select Next >.

[ XPression Maps Gateway V! = X

XPression Welcome to the XPression Maps
{Maps ) § Gateway V& -
Install Wizard

Setup will guide you through the installation of XPression
Maps Gateway.

Itis recommended that you close all other applications
before starting Setup. This will make it possible to update
refevant system files without having to reboot your
computer.

Click Next to confinue,

Mext > Cancel

Gateway Setup Wizard - Welcome
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5. On the License Agreement page, read the license agreement and select I Agree.

A XPression Maps Gateway VI = X

;
XPression Flease review the license terms before instaling XPrassion Maps
N Gateway.

Press Page Down to see the rest of the agreement,

This End User Software License Agreement is a legal agreement between you (the |
"Licensee”) and Ress Video Limited (Ross Video”) spedifying the terms and conditions of
your installation and use of the Software and all Documentation (as those terms are
defined herein).

IMPORTANT:

BY DOWNLOADING, ACCESSING, INSTALLING OR USING THE SOFTWARE AND/OR
DOCUMENTATION AND/OR BY AUTHORIZING ANY THIRD PARTY, INCLUDING WITHOUT
LIMITATION AN INSTALLER OR COMMISSIONER ACTING ON YOUR BEHALF TO DO 50,

If you accept the terms of the agresment, dick T Agree to continue. You must accept the
agreement to install ¥Pression Maps Gateway.

< Badk [ Agree Cancel

Gateway Setup Wizard - License Agreement

6. On the Folder location page, set the directory location for the Data Folder and select Next.

X If a D: drive is available, the installer will automatically set the path to use the D: drive. If not, either use the
default Data Folder location or select Browse to select a different location.

| XPression Maps Gateway V) = X

Folder location for Scenes, Examples, Output and
XPression Select the location of the Data folder.
[1aps } N

The Data folder should be ocated on a drive for data hosting.

Data Folder

D:\WFression Maps Data Browse. ..

< Back Mext = Cancel

Gateway Setup Wizard - Folder Location
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7. On the Choose Install Location page, use the default Destination Folder location or select Browse to choose
another location and then select Install.

[l XPression Maps Gateway V) = X

- Choose Install Location
XPre Choose the folder in which to install YPression Maps Gateway.
[iaps A

Setup will Install XPression Maps Gateway in the following folder, To install in a different
folder, dick Browse and select another folder, Click Install to start the installation,

Destination Folder

:\Program FilesWPression Maps Gateway] Browse...

Space required: 163.8 MB
Space available: 11.4GB

< Back Ingtall Cancel

Gateway Setup Wizard - Choose Install Location
The Installing page opens and the installation begins.

8. Once the installation has successfully completed, in the Installation Complete page, select Next.

I XPression Maps Gateway Vi -

Installation Complete
Setup was completed successfully,

XPression
| Maps

Completed

Create folder: C:'\ProgramData\Microsoft\Vindows\Start Menu\Programs \XPression . ..
Create shortout: C:'\ProgramData\MicrosoftiWindows\Start Menu'\Programs\KPressio...
Create shortout: C:\Users\Publc\DesktopMaps Data Configurator GW.Ink

Output folder: C:\Program Files\iPression Maps Gateway

symboiic link created for C:\Program Files\WPression Maps Gateway'certs <<ss=>>,,,
symboic link created for C:\Program Files\WFression Maps Gatewayljog ccmmm>>C...
Grant FullAccess on file: Ci \ProgramData‘Ross Video \KPression Maps Gateway

Output folder: C:\Program Files\WPression Maps Gateway

Created uningtaller: C:\Program Files P n Maps v\WPression Maps Gate... |
Completed

Mext > ance

Gateway Setup Wizard - Installation Complete
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The Map Data Configurator and Server Details window opens.

¢ In the Database section, ensure that the Database settings point to the host of the MariaDB server.

@]
Enabled

Database

Server Name: JOOKOOOOOOOOOIXNXK XX

Port 3306 -

User Name: mapuser

User Password: I

User IAM: O

Admin Name: root

Admin TAM: O

Gateway

Server Name: OO XXX
Cancel oK

Map Data Configurator - Server Details Window
» Server Name — The hostname or IP address of the computer hosting the MariaDB server.
» Port — The default port 3306 unless otherwise specified.
» User Name — The database user account name.
» User Password — The password associated with the user name.

» User IAM — This checkbox should be unchecked unless your database access is managed through an
external identity service.

» Admin Name — The administrative username required to make changes to the database configuration.

» Admin IAM — This checkbox should be selected only if administrator access requires authentication
through an identity management system.

¢ In the Gateway section, ensure that the Server Name field is set to the hostname or IP address of the
computer where the XPression Maps Gateway is installed.

X The Gateway section is only required when using a shared database in MOS workflows. For local installations
with a local database, this section does not apply and will not be displayed.

9. Select OK.
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10. In the Admin Password window, enter the database root password you created earlier to apply these settings.

X The root password entered here must match the password created during installation. Ensure it is stored
securely, as it will be needed for subsequent configuration and access.

11. In the Create Default User window, select Yes to create the default user that is required for the XPression
Maps HTML5 Client and grant them access to the database.

12. In the Grant User Access window, select Yes to update the user access on the server.

13. In the Map Data Configurator window, set up the two HTML5 databases with the Maria DB server so that they
can be shared.

X This step should only be performed during an initial installation; not during upgrades.

[#] Map Data Configurator

= o =
Main  Database

Type Connection Table Data Installed Newer Edit

Server available No No 14

Server available No No 34

Release: V4.0.2.13284 Namespace: new Update Versions  Setup Server

¥ Information Log

SQL ERROR: Driver not loaded Driver not loaded
SELECT databasename FROM info WHERE drivername = 'QMYSQL' AND locallocation = 0

Map Data Configurator - Initial Listing

a. Select Setup Server to open the Server Setup Process window.

[@] Server Setup Process X

o The server setup process incudes the following steps:
1.) Enter server access information.
2.) Create all need database structures.
3.) Import all local data into the server.

Vou will be guided through all process steps.

[ o | cancel

Server Setup Window

b. Select OK.

In the Server Details window, confirm that the Database and Gateway settings| 71 point to the host of the
MariaDB server and XPression Maps Gateway server, then select OK.

d. In the Gateway Setup window, select Yes to create the fullresclips table.
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e. In the Map Data Configurator window, ensure that the entries for both of the HTML5 databases appear like
the image below (Type = Server, Table = Yes, Data = Yes).

(@] Map Data Configurater - o b

Main  Database

Narme. Type Connection Table Data Tnstalled Newer Edit

1 HTMLS User

2 HTMLS Integration

Release: V4.0.2.13252

Server

Server

Namespace: new

available Yes Yes 14

available Yes Yes 34

Update Versions | Setup Server

P Information Log

Map Data Configurator - Setup Server Completed
f. Close the Map Data Configurator window.

14. On the Maps Gateway Configuration page, select Next.

4 XPression Maps Gateway V - X

- Maps Gateways Configuration
XPression Check and correct the Gateway and Database configuration
o

Gateway Settngs

Hostname:

Datzbase Settings
Hostname:

User name: .
Port: 3306

MapDataConfigurator: Reopen

Mext > Cancel

Gateway Setup Wizard - Maps Gateway Configuration
On the Maps Gateway Service page, confirm that the Maps Gateway Service was started.
a. If the last entry confirms that the service was started successfully, select Next.

b. If the last entry confirms that the service was not started, select Restart to make another attempt at starting
the Gateway service.
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15. Once the service has been started successfully, select Next.

I XPression Maps Gateway V4 - X

. Maps Gateway Service
XPression Please check if the Maps Gateway Service started eorrectly.

Updating configuration file

Starting Maps Gateway Service

“sc create mapsgatewayservice”

[5C] CreateService SUCCESS

"sc description mapsgatevayservice”

[5¢] ChangeServiceConfig2 SUCCESS

NET start mapsgatewayservice™

The Maps Gateway Service service is starting

The Maps Gateway Service service was started successfuily.

Maps Gateway Service: Restart

<Back Next > Cancel

Gateway Setup Wizard - Maps Gateway Service

* If any errors occur during service startup, resolve the issue and then select Restart to attempt starting the
service again.

16. On the Completing XPression Maps Gateway Setup page, select Finish to close the XPression Maps
Gateway Install Wizard.

B4 XPression Maps Gateway V -

XPression Compleling XPression Maps
[Map: ) 8 Gateway Setup
XPression Maps Gateway has been installed on your

computer.

Click Finish to dose Setup,

< Back Finish

Gateway Setup Wizard - Completing XPression Maps Gateway Setup
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Installing the XPression Maps Core Software

The XPression Maps Core Software installer (XPressionMaps_V4.X.X.XXX_Installer.exe) provides the ability to install
the XPression Maps application, as well as other software components and files required to support optional data
automation and interactive touch functionality. The XPression Maps Exchange Tool and the XPression Maps
Data Configurator application are also installed with the XPression Maps Core software.

The installation location of the XPression Maps Core software depends on the system configuration and workflows.
See XPression Maps Configurations and Installation Files[ 2N for more information.

For additional installation guidelines, please contact Ross Video Technical Support.

X When multiple XPression Maps software components are required to be installed on the same computer, they

must be installed in the following order: MariaDB Server, XPression Maps Gateway, and finally XPression
Maps Core software.

To install the XPression Maps Core software and its related components:

1. Copy the XPression Maps installation files to the local file system.
2. Open the folder where the installation files have been stored.
3. Double-click the XPressionMaps_VX.X.X. XXXXX_Installer.exe file to open the XPression Maps Install

Wizard.

4. On the Welcome page, select Next.

bl XPression Maps V! = X

XPression Welcome to the XPression Maps
[taps) 8 Vv

Install Wizard

Setup will guide you through the installation of XPression
Maps

It is recommended that you close all other aoplications
befare starting Setup, This will make it possile to update
relevant system files without having to reboot your
computer.

Click Next to confinue,

[ Next> Cancel

XPression Maps Install Wizard - Welcome
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5. On the License Agreement page, read the license agreement and select I Agree.

l5d XPression Maps V: = X

- License Agreement
XPrem
|

Please review the license terms before instaling XPression Maps.
Press Page Down to see the rest of the agreement.

]

This End User Software License Agreement is a legal agreement between you (the |
"Licensee”) and Ross Video Limited (Ross Video') speafying the terms and conditons of
your installation and use of the Software and al Documentation (as those terms are
defined herein).

IMPORTANT:

BY DOWNLOADING, ACCESSING, INSTALLING OR USING THE SOFTWARE ANDfOR
DOCUMENTATION ANDJOR BY AUTHORIZING ANY THIRD PARTY, INCLUDING WITHOUT
LIMITATION AN INSTALLER OR COMMISSIONER ACTIMG ON YOUR BEHALF TO DO 50,

If you accept the terms of the agreement, dick T Agree to continue., You must accept the
agresment to install XPression Maps.

< Back I Agree Cancel

XPression Maps Install Wizard - License Agreement

If a copy of the XPression Maps 3.0 software is already installed on the computer, the XPression Maps 3.0 page
opens.

6. Select Update> to copy all data and configuration files from the version 3.0 installation to the new 4.0 format
(C:\ProgrambData).

OR

Select Skip > to install only the data and configuration files from the version 4 installer without using files from
the 3.0 installation.

The files will be installed in C:\ProgramData and all registry entries will also be updated to the 4.0 format.

|4 XPression Maps Vi - X

XPressionMaps 3.0
Installation detected.

XPression
[ Maps

An X¥PressionMaps Version 3.0 installation was detected on the system.

Convert XPressionMaps 3.0

You can convert the existing installation [C:YPressionMaps_3.0] to Update »
the new XPressionMaps folder structure by pressing the Update

button.

Please wait until the installer moves to the next page.

Progress:

< Back l Skip = 1 Cancel

XPression Maps Install Wizard - Installation Detected
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7. On the Choose Components page, select the XPression Maps Core software components to be installed.
a. From the drop-down list, select one of the following presets.
> Full Install — Automatically selects the components required to install the XPression Maps Core software.

» Custom — Select when you want to install or update only specific components. Once chosen, select or
clear the individual components from the list.

AND/OR

Select the individual components to be installed. Clear its checkbox to prevent the installation or updating of
a component.

» XPression Maps — Installs the core XPression Maps application (XPression Maps) and services.
> Config & Data — Installs the configuration data files required by the core XPression Maps application.

> Blue Marble Data — Installs components required to integrate the Blue Marble Map database
(BMMap4.db) and height model files (SRTM1.db) used by the XPression Maps main application.

» Automation — Installs components required to integrate and perform dynamic data sourcing in XPression
Maps.

> Interactive — Installs the files required to operate the XPression Maps software in the Interactive Mode.

> Interactive Projects — Installs the default Project files that can be used when the XPression Maps
software is set to Interactive Mode.

» Scenes — Installs a set of sample XPression Maps scenes that can be used as templates or examples of
basic maps scenes.

> Artwork — Installs a set of sample artwork (drawings and interactive buttons) that can be used to quickly
get started creating scenes.

X An asterisk (*) indicates the component is already installed and up to date and the checkbox will be
cleared. Select the checkbox to update the component.

b. Select Next.

bd XPression Maps V! = X

~ Choose Components
XPression Choose which faatures of ¥Pression Maps you want to install,
[Maps "

Check the components you want to install and uncheck the components you don't want to
install. *Marked compenents are aready installed on the system. Click Next to continue,

Select the type of instal: Full Instal
Or, sslect the optional XPression Maps
compaonents you wish to = Config & Data
install:

*Blue Marble Data
* Automation
* Interactive
* Interactive Projects
*Scenes
* Artwork

Desaiption

FERREEE

Space required: 6.7 GB

< Back Mext > Cancel

XPression Maps Install Wizard - Choose Components
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8. On the Data Folder Location page, use the default Data Folder location or select Browse to choose another
location and then select Next.

The Data Folder stores key XPression Map files, including artwork, clips, database backups, output, projects
(and projects trash), scenes, and scene templates.

4 XPression Maps V4.0.2.13342 - X
) . Data Folder Location
XPression Select the location of the Data folder for Scenes, Examples,
[ Maps | BN  Outputand Artuwork.

The Data folder should be located on a drive for data hosting.

Data Folder

D:\Pression Maps Data Browse...

<Back | Next> | Cancel

XPression Maps Install Wizard - Data Folder Location

9. On the Integrate the Blue Marble map database page, assign the required Blue Marble map files (this only
appears if the Blue Marble Data option is selected).

X If the Blue Marble Data option has an asterisk (*) from a previous installation, this step is not required.

K If the BMMap4.db and SRTM1.db files are located in the same folder as the installer (or in its parent folder),
the file paths will be automatically populated into the dialog.

a. In the Blue Marble Map File field, select Browse to locate the BMMap4.db file and then select Open.

b. In the Height Model File field, select Browse to locate the SRTM1.db file and then select Open.

c. Select Next.

X These files must be installed from a location on the local file system as the XPression Maps system references
this file to render. For new installations, the files are provided in the XPression Maps Installation package.

kil XPression Maps V! = X

Integrate the Blue Marble map database
Select the location of the Blue Marble map database file.

XPression
{Maps |

The files (BMMap4.db, SRTM1.db) should be provided with the installer or can be taken from
a previous instalation,

If you do nat have the files, please go back to the compenent selection and disable
“Blue Marble Data”,

Blue Marble Map File (BMMap4.db)
Browse.,.
Height Model File (SRTM1.db)

Browse...

< Back Mext > Cancel

XPression Maps Install Wizard - Integrate the Blue Marble Map Database
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10. On the Choose Install Location page,
another location and then select Install.

use the default Destination Folder location or select Browse to choose

|4 XPression Maps V -

~ Choose Install Location
XPression Chaase the folder in which to install \resson Maps.
-Maps \

setup wil install XPression Maps in the following folder, To install n a different folder, dick
Browse and select another folder. Click Install to start the installation.

Destination Folder

Brovse...

Space required: 6.7 GB
Space available: 12.3 G3

< Bak Install Cancel

x

XPression Maps Install Wizard - Choose Install Location

The Installing page opens and the instal

| begins.

Once the installation has successfully completed, the Installation Complete page opens.

11. Select Next.

|4 XPression Maps V: -

XPrem
my

Installation Complete

Setup was completed successfily,

Completed

Grant FullAccess on key: \WorldNewsMapper\Rendering

Grant FullAccess on key: WorldNewsMapper \Shape

Grant FullAccess on key: WorldNewsMapper \Video

Grant Fullaccess on key: YWorldNewsMapper\WideoIO

Grant FullAccess on key: \WorldNewsMapper\Webserver

Grant FullAccess on key: \WorldNewsMapper\WebTemplates

Grant FullAccess on file: C:\ProgramDatalRoss Video|Pression Maps

Output folder: C:\Program Files\¥Pression Maps

Created uningtaller: C:'\Program Files WPression Maps \XPression Maps_Va 2 10000
Completed

Mext = ance

XPression Maps Install Wizard - Installation Complete

The Map Data Configurator window opens and is automatically populated with a list of databases.

If the system detects that any databases

are missing, the Database Missing window appears.

e Select Yes to create the databases on the local system.

Ensure all databases required to share co
available on the shared MariaDB server.

ntent are assigned a Type (Server or Local) and that their data is
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To initialize the map data configurator for a new installation of XPression Maps Core:

X WARNING - This procedure pushes database content to the shared server, which overwrites any existing data.

Only perform this procedure the first time XPression Maps Core software is installed on the first instance of a new
multiple XPression Maps Designer system.

1. Select Setup Server to open the Server Setup Process window.

(@] Server Setup Process

o The server setup process incudes the following steps:
1.) Enter server access information.
2.) Create all need database structures.
3.) Import all local data into the server.

You will be guided through all process steps.

X

l oK I Cancel

Server Setup Window

2. Select OK.

The Server Details window opens.

¢ In the Database section, ensure the Database settings point to the host of the MariaDB server.

(&
Enabled
Database

Server Name:
Port

User Name:

User IAM:
Admin Name:

Admin IAM:
Gateway

Server Name:

User Password:

200O0O0O0OOOOOOOOOOOOOOOO
3306 =
mapuser

2000C0O00OCOOOOOOOOONX

Cancel oK

Map Data Configurator - Server Details Window

> Server Name — The hostname or IP address of the computer hosting the MariaDB server.

» Port — The default port 3306 unless otherwise specified.

> User Name — The database user account name.

> User Password — The password associated with the user name.
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» User IAM — This checkbox should be unchecked unless your database access is managed through an external
identity service.

» Admin Name — The administrative username required to make changes to the database configuration.

» Admin IAM — This checkbox should be selected only if administrator access requires authentication through
an identity management system.

¢ In the Gateway section, ensure that the Server Name field is set to the hostname or IP address of the
computer where the XPression Maps Gateway is installed.

X The Gateway section is only required when using a shared database in MOS workflows. For local installations
with a local database, this section does not apply and will not be displayed.

3. Select OK.

4. In the Admin Password window, enter the password of the database root user to apply these settings.

X The root password entered here must match the password created during installation. Ensure it is stored
securely, as it will be needed for subsequent configuration and access.

All the shared databases are updated and display Server in the Type column.

5. Close the Map Data Configurator window.
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When updating an existing instance or installation on subsequent instances:

* IMPORTANT - This procedure only updates the databases' shared access (Type) setting. It does not update or
overwrite database content on the shared server.

1. Select a row in the table and press Ctrl+A to select all rows.
2. Right-click within the Type column of the table and select Set Server.

All the shared databases are updated to Server in the Type column.

[@] Map Data Configurator [C:\ProgramData\Ross Video\XPression Maps\DB\WNMDBInfo3.0.db] — (u] X
Main Database
Name Type Connection Table Data Installed Newer Edit

v Yes

| @
e

%18

28

(&

g

[

pU] OSMLocalData

-
=

PPY OceanMap
b k] CustomMaps
PP WorldCityNames

P BiueMarbleMap

P Shapes

1] UserPredefinedObjects Servi

$TY 3DModels Server

Release: Namespace: old Update Versions  Setup Server

P Information Log

Map Data Configurator - Set Server

3. Close the Map Data Configurator window.
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4. On the Installer's Maps Data Configuration page, confirm the details for accessing the maps database, then
select Next.

bid XPression Maps Vi - X

Maps Data Configuration

Chedk and correct the Maps Database configuration parameter,

XPression
{ Maps |

N

Database Settings
Hostname: -
User name:
Port: 3306
MapDataConfigurator: [ Respen

MNext > Cancel

XPression Maps Install Wizard - Map Data Configuration

5. On the Completing XPression Maps Setup page, select Finish to close the XPression Maps Install Wizard.

7 XPression Maps V4.0.2.13262 -

Completing XPression Maps Setup
[Maps .

XPression Maps has been installed on your computer.

Click Finish to dose Setup.

< Badk Finish BNCe

XPression Maps Install Wizard - Completing XPression Maps Setup
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Activating XPression Maps Licenses

A valid XPression Maps license must be activated before you can use XPression Maps or any of its components. If no
valid license is detected, the XPression Maps application will display an error at launch and display a watermark on
the Canvas.

Licenses can be activated using one of the following methods:

Activating an XPression Maps License Managed by the Ross Platform Manager (RPM)[ s

Activating XPression Maps Licenses Using a Dongle and Key Filel s

Activating XPression Maps Licenses Managed by the Ross Platform Manager (RPM)

The Ross Platform Manager (RPM) is used for centralized license management. Licenses are stored and managed
on an RPM instance within your network, and once a product key is added and activated, XPression Maps can be
configured to connect to RPM for validation during startup.

For more details on using and configuring RPM, refer to the Ross Platform Manager User Guide.

The process of activating XPression Maps licenses involves the following:

Adding XPression Maps Product Keys to RPM [33"

Activating an XPression Maps license managed by RPM/[ s

Assigning specific features to a local computer/ssh

In some environments, licensing can be managed centrally by sharing a single RPM product key across multiple
XPression Maps systems. This approach enables multiple workstations to access common licensed features and

shared data while simplifying license distribution and management.

For more information, see Configuring Multiple XPression Maps Systems with a Single RPM Product Key. s

To add XPression Maps product keys to RPM:

1. Open the Ross Platform Manager, and in the Product Key Manager select the E Add Product Key icon.
The Add Product Key window opens.

7 Add Product Key 7 X

Add Product Key

You can separate multiple product keys with a space, new line or a comma

Cancel

Add Product Key Window
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2. Paste the 15-digit product key provided by Ross Video in the Product Key field.
e You may add up to 100 product keys at once.

e Separating each 15-digit product key with a delimiter (either a space, a new line, or a comma).

KX Ensure no delimiter follows the last product key. A trailing delimiter will prevent the Add button from being
usable.

3. Select Add.

e If any product keys entered are invalid, an error message displays followed by a list of the invalid product
keys.

e Valid product keys appear in the Product Key Manager table with the status Not Activated.
P& Product Key Manager

._‘ Filter E Add Product Key m Delete Product Key t" Refresh # Settings l Edit Notes

== e = lcon  Key Product Name Licensed To Status Checked Out Expiry

o
Local |&=| | 1TEENZ-NVIMW. XPression Maps ROSS VIDED Mot Activated No Mo Expiry

u—_ ZM20Z-DVHTW-4 XPression Maps Ross RnD Not Aclivated No No Expiry

u—_ JC52R-61LHT- XPression Maps Ross RnD Not Aclivated No No Expiry

Paga of 1

Product Key Manager

4. Double-click a product key in the Product Key Manager table.

The Product Key View opens.

5. In the Product Key View, while the appropriate product key is selected, select the Request Activation
icon.

The Activate Product Key window opens.

[ Activate Product Key ? X

Activate Product Key

Product Key JC52R-61LH7-

Product Version (Optional)

| Activate | | Cancel

Activate Product Key Window

6. Enter the Product Version for the current product instance.

7. Select Activate.
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8. Confirm that the product key status now shows Activated (highlighted in green) in the Product Key Manager.

Status

Activation Request Pending

One or more features expired
Activated <::

Activation Request Pending

Product Key Manager - Activated Status
9. Repeat from steps 4-8 for each additional product key.

To activate an XPression Maps license managed by the Ross Platform Manager:

1. Ensure you have a copy of your XPression Maps product key.
2. Open the XPression Maps RPM License Manager:
a. On the computer hosting XPression Maps, go to C:\Program Files\XPression Maps\bin64.

b. Double-click XPressionMapsRPMLicenseManager.exe.

4 XPression Maps RPM License Manager - o x
File Licenses

Licenses

Key Selected  ProductKey Product Name Licensed To Purchased Date Expiry Maintenance Expiry

XPression Maps RPM License Manager
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3. Configure the connection to the Ross Platform Manager.

a. Open File>Preferences and select the License tab.

b+ Preferences ? X

License Proxy
Licenses
File: m Files/XPression Maps/bin64\.. \DB'\Licenses.db
Server Type

© Ross Platform Manager () Activation Server

Ross Platform Manager

Hostname:

Port: 443 5 Use HTTPS connection

License Manager

) pebug Mode Encrypted

‘ Cancel | oK

XPression Maps RPM License Manager - Preferences - License

b. In the Licenses section, confirm or enter the path to license database file (C:\Program Files\XPression
Maps\DB\Licenses.db).

c. In the Server Type section, select Ross Platform Manager to connect to the instance of RPM which resides
locally in your environment.

d. In the Ross Platform Manager section, in the Hostname field, enter the url of the RPM instance.
e. Select OK.

X Each computer connecting to RPM records its local hostname when consuming a license. This allows tracking

of which machine is using which features. When one product key is shared across multiple computers, RPM
displays each hostname separately in the license allocation table.

4. Add your license key from RPM to the XPression Maps RPM License Manager.

a. In your Ross Platform Manager, go to the Product Key Manager and select an XPression Maps license.
Double-click the license and select Copy Product Key to copy the code to the clipboard.
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b. In the XPression Maps RPM License Manager, open the Add Product Key window by selecting Licenses

> Add Product Key.

b4 Add Product Key ? X

License Key:

| OK ‘ Cancel

XPression Maps RPM License Manager - Add Product Key
c. Paste the product key into the License Key field.
d. Select OK.

The product key appears in the Licenses table.

(Optional) Select the product key in the Licenses table to display a listing of its licenses in the Features

section below.

b4 XPression Maps RPM License Manager - 0o X
Fille Licenses
Licenses
Key Selected Product Key Product Name Licensed To Purchased Date Expiry Maintenance Expiry
W e e o o R
Features
Selected Feature Name Number Activation Limit Current Activations Purchased Purchased Date Expiry Maintenance Expiry  Licensed To Departrent
1 [ XPressionMaps Designer 1 1 0 1 20050024 None 2026-08-23 Graphics Department XN
2 XPression Maps Server 1 1 0 1 20050824 None 2026-08-24 Graphics Department ~ XPN\
3 [ XpressionMaps Touchscreen Option 1 1 0 1 20050024 None 2026-08-24 Graphics Depatment  XPN
4 XPression Maps Database Option 1 1 0 1 20050624 None 2026-08-24 Graphics Depatment ~ XPN
5 XPression Maps Dataling Optien 1 1 0 1 20250024 None 2026-08-24 Graphics Depatment ~ XPN
6 XPression Maps MOS Download Option 1 1 0 1 20050824 None 2026-08-24 Graphics Department  XPN
7 [ XPressionMaps Designer Trial 1 0 0 1 2050024 None 2026-08-24 Graphics Department  XPN

XPression Maps RPM License Manager - Features

37
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5. Validate the activation of your license by performing a license test.
a. With the product key selected in the Licenses table, from the menu bar, select Licenses > Test License.
b. In the License Test window, select Test.

The results will indicate a successful activation.

—
B License Test 7 X

Product Key: N355H-L1ZXK-XXXXX TestlN ‘

Feature [XPression Maps Server] added to the activation list!

Feature [XPression Maps Database option] added to the activation list!
Feature [XPression Maps External Data option] added to the activation list!
Feature [XPression Maps MOS Client option] added to the activation list!
Activation for Feature [XPression Maps Server] Succeeded!

Activation for Feature [¥Pression Maps Database option] Succeeded!
Activation for Feature [¥Pression Maps External Data option] Succeeded!
Activation for Feature [¥Pression Maps MOS Client option] Succeeded!
Activation for Feature [¥Pression Maps Server] Succeeded!

Activation for Feature [¥Pression Maps Database option] Succeeded!
Activation for Feature [¥Pression Maps External Data option] Succeeded!
Activation for Feature [XPression Maps MOS Client option] Succeeded!

| Dane

XPression Maps RPM License Test

c. Select Done to close the License Test window.
To assign specific features to a local computer:

1. In the Licenses table, select the product key.
2. In the Features section, check the boxes in the Selected column to assign features to the current machine.

Example: On a designer workstation, you may only enable XPression Maps Designer and XPression Maps
Datatlinq option.

3. Review license usage:
o Activation Limit shows the number of available activations.
e Current Activation shows the number currently in use.

4. Repeat this process on each additional computer as needed.

Each system will appear under its hostname in RPM, making it easy to track which machine is using which
features.
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Configuring Multiple XPression Maps Systems with a Single RPM Product Key

In facilities where multiple users require access to XPression Maps across different machines, a single Ross Platform
Manager (RPM) Product Key can be shared. For example, an XPression Maps Server with DataLing may run in the
control room, while an XPression Maps Designer workstation is used in the Art Department.

The following procedures illustrate an example workflow for configuring multiple XPression Maps systems with a

shared RPM product key. Adapt the process as appropriate for your environment.

To configure the XPression Maps Server:

1. On the XPression Maps Server go to C:\Program Files\XPression Maps\bin64 and double-click
XPressionMapsRPMLicenseManager.exe.

The XPression Maps RPM License Manager opens.

4 XPression Maps RPM License Manager - o x

File Licenses

Licenses

Key Selected Product Key Product Name Licensed To Purchased Date Expiry Maintenance Expiry
I T e e e e

Features
Selected Feature Name Number Activation Limit Current Activations Purchased Purchased Date Expiry Maintenance Expiry Licensed To Department

1 XPression Maps Designer 1 0 1 2025-08-24  None 2026-08-23 Graphics Department  XPN

1
2 XPression Maps Server 1 1 0 1 2025-08-24 None 2026-08-24 Graphics Department  XPN

@  XPression Maps Touchscreen Option 1 1 1 None 2026-08-24 Graphics Department  XPN
4 XPression Maps Database Option 1 1 0 1 None  2026-08-24 Graphics Department  XPN
5 XPression Maps Dataling Option 1 2 1 None  2026-08-24 Graphics Department  XPN
6 XPression Maps MOS Download Option 1 1 0 1 2025-08-24 None 2026-08-24 Graphics Department  XPN

XPression Maps RPM License Manager
Confirm the product key has been installed through RPM.
For information on how to install product keys with RPM see adding XPression Maps product keys to RPM/s3).
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2. In the features section, select the checkboxes for:
¢ XPression Maps Designer
¢ XPression Maps Datalinq Option
e XPression Maps MOS Download Option

¥4 XPression Maps RPM License Manager - o x

File Licenses

Licenses

Key Selected Product Key Product Name Licensed To Purchased Date Expiry Maintenance Expiry

I T T e e

Features
Selected Feature Name Number Activation Limit Current Activations Purchased Purchased Date Expiry Maintenance Expiry Licensed To Department
1 XPression Maps Designer 1 1 1 None  2026-08-23 Graphics Department  XPN
2 [ [XPression Maps Server 1 1 1 None  2026-0 Graphics Department XPN
3 [ |Keression Maps Touchscreen Option 1 1 1 None  2026-08-24 Graphics Department  XPN
4 [ [XPression Maps Database Option 1 1 0 1 None  2026-08-24 Graphics Department  XPN
5 [XPression Maps Dataling Option 1 2 1 None  2026-08-24 Graphics Department  XPN
6 @ [XPression Maps MOS Download Option 1 1 0 1 2025-08-24 None 2026-08-24 Graphics Department XPN

XPression Maps RPM License Manager - Selected Features
3. Minimize the XPression Maps RPM License Manager and launch XPression Maps Server.

4. Return to the XPression Maps RPM License Manager and select the Product Key, then go to Licenses > Test
License.

The License Test window opens.

Product Key: N355H-L 1ZXK-X0000C Test

Done

XPression Maps RPM License Manager - License Test Window
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5. Select Test.

The test results confirm the selected features are active and display the Activation Limit.

The Features table shows how many activations are available for each feature.

License Test ? X

Product Key: N355H-L 1ZXK-X00X Test

Feature [XPression Maps Server] added to the activation list!

Activation Limit can be reached for this feature!

Feature [XPression Maps External Data option] added to the activation list!
Feature [XPression Maps MOS Client option] added to the activation list!
Activation Limit can be reached for this feature!

Activation for Feature [XPression Maps Server] Succeeded!

Activation for Feature [XPression Maps External Data option] Succeeded!
Activation for Feature XPression Maps MOS Client option] Succeeded

Done

XPression Maps RPM License Manager - Testing License

6. Select Done.
The License Test window closes.

In the XPression Maps RPM License Manager, select the Product Key and go to Licenses > Refresh Licenses.

e In the Features section, confirm the Current Activations column shows the XPression Maps Server,
XPression Maps Datalinq Option, and XPression Maps MOS Download Option as active.
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To configure the XPression Maps Designer workstation:

1. On the system running XPression Maps Designer, go to C:\Program Files\XPression Maps\bin64 and double-
click XPressionMapsRPMLicenseManager.exe.

The XPression Maps RPM License Manager opens.

14 XPression Maps RPM License Manager - o X
File Licenses
Licenses

Key Selected Product Key Product Name Licensed To Purchased Date Expiry Maintenance Expiry

1 N355H-L1ZXK-X000X XPression Maps. m 2025-08-24 m 2026-08-23

Features

Selected Feature Name Number Activation Limit Current Activations Purchased Purchased Date Expiry Maintenance Expiry Licensed To Department

1 XPression Maps Designer 1 1 0 1 2025-08-24 None 2026-08-23 Graphics Department  XPN
2 XPression Maps Server 1 1 0 1 None  2026-08-24 Graphics Department  XPN
3 XPression Maps Touchscreen Option 1 1 0 1 None  2026-08-24 Graphics Department  XPN
4 g XPression Maps Database Option 1 1 0 1 None  2026-08-24 Graphics Department  XPN
5 XPression Maps Dataling Option 1 2 0 1 None  2026-08-24 Graphics Department  XPN
6 XPression Maps MOS Download Option 1 1 0 1 2025-08-24 None 2026-08-24 Graphics Department ~ XPN

XPression Maps RPM License Manager
Confirm the correct product key has been installed through RPM.
For information on how to install product keys with RPM see adding XPression Maps product keys to RPM/ a3,
2. In the Features section, select the checkboxes for:
e XPression Maps Designer

e XPression Maps Datalinq Option

)4 XPression Maps RPM License Manager - o x
File Licenses
Licenses

Key Selected Product Key Product Name Licensed To Purchased Date Expiry Maintenance Expiry

1 N355H-L1ZXK-X000X XPression Maps| m 2025-08-24 m 2026-08-23

Features
Selected Feature Name Number Activation Limit Current Activations Purchased Purchased Date Expiry Maintenance Expiry Licensed To Department

1 XPression Maps Designer 1 1 0 1 2025-08-24 None 2026-08-23 Graphics Department  XPN
2 [ |xeression Maps Server 1 1 0 1 2025-08-24 None 2026-08-24 Graphics Department  XPN
3 [ |XPression Maps Touchscreen Option 1 1 0 1 2025-08-24 None  2026-08-24 Graphics Department  XPN
4 [ [XPression Maps Database Option 1 1 0 1 2025-08-24 None 2026-08-24 Graphics Department  XPN
5 @ |[xpression MapsDataling Option 1 0 1 2025-08-24 None  2026-08-24 Graphics Department  XPN
6 [ [xpression Maps MOS Download Option 1 1 0 1 2025-08-24 None 2026-08-24 Graphics Department  XPN

XPression Maps RPM License Manager - Designer Workflow

3. Minimize the XPression Maps RPM License Manager and run XPression Maps Designer.
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4. Return to the XPression Maps RPM License Manager and select the product key, then go to Licenses > Test
Licenses.

The License Test window opens.

Product Key: N355H-L 1ZXK-X0000C Test

Done

XPression Maps RPM License Manager - License Test Window
5. Select Test.

The License Test window confirms the selected features are active.

License Test

? X

Product Key: IN355H-L 1ZXK-30000

Feature [XPression Maps Designer] added to the activation lst!

Feature [XPression Maps External Data option] added to the activation list!
Activation for Feature [XPression Maps Designer] Succeeded!

Activation for Feature [XPression Maps External Data option] Succeeded!

Done |

XPression Maps RPM License Manager - Testing License
6. Select Done.

The License Test window closes.

7. In the XPression Maps RPM License Manager, select the product key and go to Licenses > Refresh Licenses.

e In the Features section, check the Activation Limit and Current Activations columns.

e Confirm both the XPression Maps Server and XPression Maps Designer appear as active.
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To configure an additional workstation:

1. On the additional workstation navigate to: C:\Program Files\XPression Maps\bin64 and double-click
XPressionMapsRPMLicenseManager.exe.

The XPression Maps RPM License Manager opens.

14 XPression Maps RPM License Manager - o X
File Licenses
Licenses

Key Selected Product Key Product Name Licensed To Purchased Date Expiry Maintenance Expiry

1 N355H-L1ZXK-X000X XPression Maps. m 2025-08-24 m 2026-08-23

Features

Selected Feature Name Number Activation Limit Current Activations Purchased Purchased Date Expiry Maintenance Expiry Licensed To Department

1 XPression Maps Designer 1 1 0 1 2025-08-24 None 2026-08-23 Graphics Department  XPN
2 XPression Maps Server 1 1 0 1 None  2026-08-24 Graphics Department  XPN
3 XPression Maps Touchscreen Option 1 1 0 1 None  2026-08-24 Graphics Department  XPN
4 g XPression Maps Database Option 1 1 0 1 None  2026-08-24 Graphics Department  XPN
5 XPression Maps Dataling Option 1 2 0 1 None  2026-08-24 Graphics Department  XPN
6 XPression Maps MOS Download Option 1 1 0 1 2025-08-24 None 2026-08-24 Graphics Department ~ XPN

XPression Maps RPM License Manager

Confirm the correct product key has been installed through RPM.

For information on how to install product keys with RPM see adding XPression Maps product keys to RPM/ a3,
2. In the Features section, select the checkboxes for:

e XPression Maps Designer

)4 XPression Maps RPM License Manager S
File Licenses
Licenses

Key Selected Product Key Product Name Licensed To Purchased Date Expiry Maintenance Expiry

Features
Selected Feature Name Number Activation Limit Current Activations Purchased Purchased Date Expiry Maintenance Expiry Licensed To Department

1 XPression Maps Designer 1 1 0 1 5 Graphics Department XPN
) |Xpression Maps server 1 1 0 1 None  2026-08-24 Graphics Department  XPN

3 (3 |XPression Maps Touchscreen Option 1 1 0 1 None  2026-08-24 Graphics Department  XPN
4 [ |XPression Maps Database Option 1 1 0 1 2025-08-24 None  2026-08-24 Graphics Department  XPN
5 [ |XPression Maps Dataling Option 1 2 0 1 2025-08-24 None 2026-08-24 Graphics Department XPN
6 [ |XPressionMapsMOS Download Option 1 1 0 1 2025-08-24 None  2026-08-24 Graphics Department  XPN

XPression Maps RPM License Manager - Additional Designer Workflow

3. Minimize the XPression Maps RPM License Manager and run XPression Maps Designer.
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4. Return to the XPression Maps RPM License Manager and select the product key, then go to Licenses > Test
Licenses.

The License Test window opens.

Product Key: N355H-L 1ZXK-X0000C Test

Done

XPression Maps RPM License Manager - License Test Window
5. Select Test.

The License Test window confirms the selected features are active.

b4 License Test ? X

ProductKey: N355H-L 12XK-X000 Test |

Feature [XPression Maps Designer] added to the activation list!
Activation for Feature [XPression Maps Designer] Succeeded!

Done

XPression Maps RPM License Manager - Testing License
6. Select Done.
The License Test window closes.

7. Launch XPression Maps Designer.

K If the activation limit is reached, a prompt appears stating that no XPression Maps Designer activations are

available. The workstation cannot proceed until a license is released. You must either wait for a license to
become available or coordinate with colleagues to free one.

# | RPM License X

” License limit (1) reached for feature [XPression Maps Designer]

Activation Limit has been reached
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Activating XPression Maps Licenses Using a Dongle and Key File

The dongle and key file method provides a secure way to activate XPression Maps licenses. This approach requires a
USB dongle and a matching key file to be installed on the host computer. The dongle serves as the hardware
authentication device, while the key file contains encrypted license data linked to the dongle's unique serial ID.

When you purchase XPression Maps, a USB dongle is included in the installation package, with labels on the
packaging and chain identifying its Serial ID. This Serial ID must be provided when requesting the key file, and the
values must match in order to successfully activate the license.

To activate an XPression Maps license using a dongle and key:

1. Insert the XPression USB dongle into the host computer.
¢ On the host computer, ensure that all XPression Maps software components are closed.
e Navigate to the location where the XPression Maps software was installed.

2. Add a copy of the XPression Maps key file (RockeyLicense_XXXXXXXX.xml) to the C:\Program Files\XPression
Maps\bin64\key folder.

If you do not have the XPression Maps key file, contact Ross Video Technical Support to request the file. You will
need to provide the dongle's Serial ID number from the label on the dongle's packaging and chain. Alternatively,
you can find the dongle's Serial ID by opening the XPression License Tool, right-click on the dongle and select
Copy to Clipboard. Pasting the contents of the clipboard into a text editor will display the Serial ID.

3. Open the XPression Maps application to ensure that no licensing errors appear.
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Opening XPression Maps User Interfaces

Once the XPression Maps software components are installed, you can open the following XPression Maps user
interfaces on the computers upon which the software is installed:

XPression Maps! 47

XPression Maps Touchl 47

XPression Maps Exchange Tool 4"
XPression Maps Data Configurator| s

To open the XPression Maps application:

e Double-click on the XPression Maps desktop icon:

OR
e Open the XPressionMaps.exe from the installation location (default: C:\Program Files\XPression
Maps\bin64\XPressionMaps.exe).

To open the XPression Maps Touch application:

e Double-click the XPression Maps desktop icon:

OR

e Open the XPressionMaps.exe from the installation location (default: C:\Program Files\XPression
Maps\bin64\XPressionMaps.exe).

The window's title bar should display XPressionMaps VX.X Interactive. If the title bar does not include
Interactive, then the application is not set to Interactive mode. Select File > Preferences > Output and ensure
that the application is currently set to start in Interactive mode (Start in Interactive Mode) and that a valid
XPression Maps Touch license has been activated, then restart the application.

. ROSS




XPression

To open the XPression Maps Exchange Tool:

e Double-click the Maps Exchange Tool desktop icon:

AY s
[ wap
. -

OR

¢ Open the MapsExchangeTool.exe from the installation location (default: C:\Program Files\XPression

Maps\MapsExchangeTool).

4 XPression Maps Exchange Tool V.

Manage Deploy Project

— Archi
Archive

Name:

Scene | Drawing | Shape Style

Done

XPression Maps Exchange Tool
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To open the XPression Map Data Configurator:

e Double-click the Map Data Configurator desktop icon:

]
OR

e Open the Map Data Configurator from the installation location (default: C:\Program Files\XPression
Maps\MapDataConfigurator).

[@] Map Data Configurator [C:\ProgramData\Ross Video\XPression Maps\DB\WNMDEInfo3.0.db) - [m] x
Main  Database
Name Type Connection Table Data Installed Mewer Edit

1 Main Local available Yes Yes 33

2 HTMLS User Server available Ves Yes 14

3 HTMLS Integration Server available Yes Yes 34 -

4 Tilecache Local available Yes Yes

5 DrawingFeatures Server available Ves Yes 13

&6 CustomShapes Server available Ves Yes 1.0 -

7 SceneStyles Server available Ves Yes 11

§ ShapeStyles Server available Yes Yes 1.1

9 SafeTitle Server available Ves Yes 1.0 -

10 OSMLocalData Server available Ves Yes 1.0

11 HeightMap Local available Yes Yes

12 OceanMap Local available Ves Yes

13 CustomMaps Server available Yes Yes 1.0

14 WorldCityNames Local available Yes Ves

15 BlueMarbleMap Local available Yes Yes

16 Shapes Server available Yes Yes 34

17 DisputedBorders Server available Ves Ves 1.0

18 UserPredefinedObjects Server available Yes Yes 1.1

19 3DModels Server available Yes Yes 1.0

20 ProviderRequests Server available Yes Wes 1.0 -
Release: V Namespace: ald Update Versions  Setup Server

b Information Log

Map Data Configurator
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Uninstalling XPression Maps Software Components

As part of the installation process, each of the XPression Maps installers (XPression Maps and Gateway) also
provides an executable file that can be used for uninstalling the software. These uninstall files are always saved to
the same location where the software was installed. The table below identifies file names and the default locations.
Running the uninstall file opens an Uninstall Wizard that guides you through the process of uninstalling the
software.

* Carefully read each page in the Uninstall Wizard as some options offer you to perform a full uninstall, while
others allow you to perform a partial uninstall by preserving components that contain user data that can be used
during an upgrade or future installation.

Uninstaller File Name Default Install Location

XPression Maps_VX.X.X.XXXXX_uninstall.exe C:\Program Files\XPression Maps

XPression Maps Gateway_VX.X.X.XXXXX_uninstall.exe C:\Program Files\XPression Maps Gateway
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XPression Maps Port Requirements

The following diagram illustrates the port requirements for the various XPression Maps system components.

XPression Maps 4.0 Port Requirements

(@ mapbox
B® Microsoft Azure )
> Bing maps )J

OpenStreetMap

Port 8100

Newsroom User

XPression Maps Port Requirements

Maps MOS HTMLS Client to Maps Server (Database & Gateway)
Maps Server to Maps Gateway

Maps Designer and Gateway to Maps Server MariaDB

Maps HTML5 MOS Client to Maps Server for Data

Maps Touch HTML5 Client to Maps Gateway

Maps Touch HTMLS Client to Maps Engine (Touch)

Maps Designer and Server to Mapbox, Microsoft Bing! or Azure Maps
Maps Designer and Server to OpenStreetMaps Servers

Maps Design, Server, Touch to Ross Platform Manager

A

2

Newsroom User

Map Client
Browsing
Port 80
Fort 443 for SSL

18877

Field Reporter User

Microsoft
Bing! Maps,
Azure Maps or
Mapbox and
Open Street
Map Client
Browsing
Port 80
Port 443 for SSL
Fort 8877

|

Data and Imagery

—

—

Map Templates, Data,
1 Icons and Media Files
XPression Maps o e

Designer Workstation

- XPression Maps Gateway

MOS Client Traffic

Internal Data Communications
Internet Content Access
Control Communications
Video I/O

XPression Maps Port Requirements

XPression Maps Server wmarizns
- XPression Maps Database (MariaDB) Hosted on

v

Newsroom User

XPression Gateway Server

XPression Engine (1RU)
(XPression Studio or BlueBox)

XPression Maps Touch

Ports 80 or 443 (for SSL)
Port 9977

Port 33006

Port 8877

Port 80, 443 (for SSL)
Port 7770, 8880

Port 80

Port 8100

Port 80 (or 443 for SSL)

XPression Maps
Touch
HTML5 Client

XPression
Maps Touch
HTMLS Control
Port 3380
Port 7770

« XPression Maps Touch
HTMLS Browser to
XPression Maps Gateway
Fort 80 (or 443 on S5L)
>y

Map Templates,
Data, Icons and

XPression Maps Touch
(XPression 1RU SDI or IP Engine)

XPrassion
Maps Server
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